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Chapter 18
Assembly Modeling with the LEGO® MINDSTORMS®
NXT Set — Autodesk Inventor

Feaining[Objective’s

¢ Create an Assembly Using Parts from
the LEGO® MINDSTORMS® NXT Set

¢ Understand and Perform Proper
Constraints in Assembly

¢ Adjust Components’ Orientations

¢ Create and Use Subassembilies in
Assemblies
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Introduction

The rapid development in computer hardware technology, during the past few decades,
has brought many changes in the practice of engineering in general. Many areas that were
traditionally identified as electrical engineering or mechanical engineering are now
multidisciplinary, integrating digital electronics, kinematics analysis, and computing
together. Additionally, the use of microcontrollers and embedded systems has become
inevitable in almost every engineering field. Given these developments, engineering
education has also witnessed significant changes, such as adapting to project-oriented
courses that emphasize real world applications, and the use of new educational tools such
as robot kits.

The use of robot kits provides many benefits, through assembling, building, and
following instructions, which help develop fine motor skills and hand-eye coordination.
Students are exposed to multiple subjects such as mechanics, electronics, and
programming. By working together to create robots that perform exciting challenges,
students also gain valuable critical thinking, problem-solving and team-building skills.
Students can also participate in several national/world robot competitions held annually,
which can provide a strong sense of accomplishment.

In this lesson, we will create a Basic Car assembly model using the LEGO®
MINDSTORMS® NXT Set. The modeling process can be used as part of a design
process, to simulate and confirm a design, prior to the actual construction of the project.
All of the required parts/subassemblies have been modeled in Autodesk Inventor, and can
be found on the publisher’s website. Also provided are additional design ideas and
resource information. Unzip all of the parts/subassemblies under a folder in the
Parametric-Modeling-Exercises project folder before starting on the next section.

The Basic Car Assembly
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Modeling Strategy
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Starting Autodesk Inventor

1. Select the Autodesk Inventor option on the Start menu or select the
Autodesk Inventor icon on the desktop to start Autodesk Inventor. The
Autodesk Inventor main window will appear on the screen.

“I

Get Started [JUEEIERENGNE 2. Select the New File icon with a single click of the

D E % @ ﬂ left-mouse-button in the Launch toolbar as shown.

Mew | Open Projects Open  Welcon

Samples 3. Select the English units set and in the Template
_I New (Ctrl+N) i Launch list, select Standard(in).iam (Standard Inventor
x Assembly Model template file).
G|
‘. Templat.es ¥ Part - Create 2D and 3D objects M
4. Click on the Create & yrn

button in the New File > Meld Design @ @
dialog box to accept the Sheet Standard
selected settings. oy

¥ Assembly — Assemble 2D and 3D components

Hh b &

Maold |Standard | Weldment
Design (in).[%‘m (AMNST).iam
(in).iam

L
Inspect Tools  Manage  View  Eny
| B customize @@ | O Inthe Ribbon toolbar, select the Tools tab.
-
&pplication | Docurnent # 6. Select the Document Settings command as
Options | Settiags él]:. rdd-Ins shown.
Document Settings
7. Inthe Assemblyl Document Settings dialog -
box, click on the Units tab as shown. Standard Units | skech | Modelng | 6il o
— Unit=s
8. Set the Length Units to millimeter as Length
shown. W
9. Click on the OK button to accept the Angle
selected settings. [dearee ~|

e The Standard Inventor Assembly Model template file contains predefined settings
including default 3D view orientation and default 2D drawing views setup. With
Autodesk Inventor, we are allowed to mix units within the same file.
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Creating a Subassembly

*» We are now ready to assemble the components together. We will start by assembling
the NXT Motor, Bushings and Pegs into a Motor subassembly. A subassembly is
a unit assembled separately but designed to fit with other units in a manufactured
product. Subassemblies are commonly used to help manage complex designs and
when the same configurations are used multiple times in a design. Note that a
subassembly behaves just the same as a part within an assembly; i.e., a subassembly
possesses only six degrees of freedom, just like a regular part. Any moving parts
within a subassembly become fully locked inside the main assembly.

I
ﬂ -l 1. Switch to the Assembly panel, and select the Place

Assemble [ISTRTIT Component command by left-clicking the icon.
D-\- E |J|'
p|acaiF - 2. Select NXT Motor.iam (switch to the appropriate
" | Place Component (P) folder if necessary) in the list window. Note this is a
Com| Specifies one or more files § subassembly containing five parts.
o L
Place Component e |
Lok, ir: Il‘j‘ Basic Car j @ ?’ & -
ent Center Files MxT brick - Jack2.ipk %NXT Light Sensor.iam %Nm
MxT brick - screend.ipk @NXT mokar - Base.ipk @NX‘I
MxT brick - Screenz.ipt @NXT mokor - Conneckor.ipt @NX‘I
MXT Brick.iam [ hT mator - Drive. ipt rn
KT light sensor - Base.ipk @NXT maokor - Housing.ipk %NX‘I
MXT light sensar - Light Red.ipt [ JNXT matar - Jack.ipt L
MxT light sensor - Light White, ipt @NX‘I
MxT light sensor - Top.ipk My T Bound sensor - Base.ipk @Nm
. 1 i
File name: INXT M ator.iam j
Files of type: ICDmponent Files [ipt; ".iam] j
Project Fila: IParametric—MndeIing—Exercises.ip]' j Projects. .. |
Cick. Launch iMates
e
@l |7 “ | T, | |7 @ | =0 Find ... | Cpkions. .. | Qipern | Zancel |
A4

3. Click on the Open button to retrieve the model.

_ _ 4. Right-click once to bring up the option menu and select

Place Grounded at Origin to place the part.

5. Right-click once to bring up the option menu and select
ne View | OK to end the command.
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Placing the Next Component

» We will retrieve the Peg 7-module part as the next component of the assembly
model.

ﬂ IR “'_.h H 1. In the Assembly panel, select the Place Component
Assemble TN command by left-clicking the icon.

- ‘*’G Free Moy

(] ]
Placf\?_ .| O Free Rotd
"| Place Component (F) | 2. Select the Peg 1-module design in the list window.
CI‘JI‘T Specifies Qne or more f||g Clle on the Open button tO retl‘ieVe the mOdel.

3. Place two copies of the
Peg 1-module part
toward the left side of
the graphics window, as
shown in the figure.

4. Inside the graphics window, right-click once to bring up the

_@* option menu and select OK to end the placement of the Peg 7-
module part.

(2]

Y | “rAssemblyView ~ #| o Inside the browser window, the retrieved parts are

[ Assembly1 listed in their corresponding order. The pin icon in
[ Relationships front of the NXT Motor assembly signifies the
[e] Representations component is grounded and all six degrees of freedom
[ Crigin are restricted. The number behind the name is used to
255 NXT Motor: 1 identify the number of copies of the same component
() Peg 1-module: 1 in the assembly model.
@ Peg 1-module: 2
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Degrees of Freedom Display

Each component in an assembly has six degrees of freedom (DOF), or ways in
which rigid 3D bodies can move: movement along the X-, Y-, and Z-axes
(translational freedom), plus rotation around the X-, Y-, and Z-axes (rotational
freedom). Translational DOFs allow the part to move in the direction of the specified
vector. Rotational DOF's allow the part to turn about the specified axis.

|
Translational DOF f——omo / Rotational DOF

|: T g™ Center of Gravity

|_-E Degrees of Freedom |

| » Select the Degrees of Freedom option in the
Object View tab to display the DOF of the unconstrained

Visibility . @&) iMate Gly component.
Degrees of

In parametric modeling, the degrees of freedom symbol shows the remaining degrees
of freedom (both translational and rotational) for the components of the active
assembly. Note that each component has its own degrees of freedom, even if the same
part is placed multiple times within the same assembly. The assembly constraints are
also applied independently to each component. The set of degrees of freedom
symbols, as shown in the figure above, signifies each copy of the Peg 7-module is
unconstrained and should be constrained independently.
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Apply the Assembly Constraints

Jesign U Model Inspect Ii
@ ‘:F I:EI;- Show 1
L.CJ .
loint |Constpain|
% n:ﬁ;; Hide All
Relationships +

2. Inthe Place Constraint dialog box,
confirm the constraint 7Type is set to
the Mate constraint.

In the Assembly panel, select the Constrain
command by left-clicking once on the icon.

Place Constraint &3
Assembly | Motion | Transitional | Constraint Set |
Type Selections
FIEENEIEN =
Offset: Solution
&’ [CEF
| ok |[ cancel || Apply |

3. Select the ring surface of the
NXT Motor Drive as the
first item for the Mate
Alignment command.

4. On your own, use the View-
Cube and rotate the display
to view the opposite side of
the Peg 1-Module parts.

5. Click on the back ring face of
the Peg 1-Module part as
the second part selection to
apply the constraint.

6. Click on the Apply button to
accept the selection and apply
the Mate constraint.

el
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Place Constraint

Offset:

Solution

0,000 mm

¥ 6o CEF

=]
Assembly | Motion | Transitional | Constraint Set |
Type Selections
Eaama EE oo

e

|

Ok

Apply |

8. Select the right
cylindrical surface of
the base component,
the chassis rail, as the
first item for the Mate
Alignment command.

. In the Place Constraint dialog
box, confirm the constraint 7Type is
set to the Mate constraint.

9.

10.

Click on one of the
outside cylindrical
surfaces of the Peg
1-Module part as
the second item to
apply the constraint.

Click on the Apply
button to accept the
selection and apply
the Mate constraint.

Nl
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11. On your own, repeat the above steps and constrain the other Peg 1-Module as
shown.

%

o,

e Note there is still one rotational
degree of freedom available.

12. In the Assembly panel, select the Place Component
command by left-clicking the icon.

Aszemble ERSTLTINGY

d’ '*'g Free Moy
[ﬁ, | % Free Rots 13. Select the Beam 3-Module design in the list window.
Plagt—feasta Click on the Open button to retrieve the model.

-

Place Component (P)

Com Specifies one or more fild

14. Place one copy of the
Beam 3-Module toward
the left side of the
graphics window, as
shown in the figure.

15. Inside the graphics
window, right-click once
to bring up the option
menu and select Done to
end the command.
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(A \:F & Show 16. In the Assembly panel, select the Constrain

command by left-clicking once on the icon.
Joint Const&in

& Hide All ‘

Relationships = Place Constraint =

Assembly | Motion | Transitional | Constraint set |

Selections

Type
17. In the Place Constraint dialog E@@ i

box, confirm the constraint 7Type Offset: Solution

is set to the Mate constraint. 0.000 mm N | i I @‘

v &o' R

| ok |[ cancadl || apply |

18. Select the front vertical
surface of the base component,
the chassis rail, as the first item
for the Mate Alignment
command.

19. Click on the front
surface of the
Beam 3-Module
part as the second
part selection to
apply the constraint.

20. Click on the Apply
button to accept the
selection and apply
the Mate constraint.
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21. Select the right inside
cylindrical surface of the Beam
3-Module component, the chassis
rail, as the first item for the Mate
Alignment command.

22. Click on the outside

23.

cylindrical surface of the
right Peg 1-Module part as
the second item to apply the
constraint.

Click on the Apply button
to accept the selection and
apply the Mate constraint.

el

24. On your own, align the
center axis of the left feature
to the center axis of the
other Peg 1-Module part as
shown.
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Assemble the Next Components

+» Next, we will assemble copies of the Bushings and Axle parts.

1. Inthe Assembly panel, select the Place Component
command by left-clicking the icon.

Assemble EETGT0N

[ Ci" "I"G Free Moy
Place Component 2=
- OC‘ Free Rotg
+
P'Td*- e p Look ir: I@ Basic Car j G _" O i
PlaCE' Cﬂm pCI-nEHt I:Fl:] Beam 11-module.ipt Fra
- - Beam 13-module.ipt Busiagg.ipt %Fra
Corr SFIEC”:IES COne or maore ﬂli Beam 15-module.ipt @Bushing-N‘ipt EiFuII
Beam Angular-2x4.ipt @Cross EBlock 2-madule.ipt %Hae
Beam Angular-3x=5.ipt @Cross Block 21 module.ipt @Hut
Beam Angular-4:x6 .ipt @Cross Block 3-madule.ipt @Hul:
Eeam double bent-7x1x2.ipt @DC Geathead Motor . ipk @Hul:
2. SeleCt the Bushing Axle Extender.ipt %Frame-Center.iam %Mot
Bushing half « 1 2
design in the list Fie name: — [Bushing half ot =
Wlndow. Cllck on Files of type: IComponenl Filez [*.ipt; ".iam] j
the open button Project File: IParametric-MDdeI\ng-Exercises.ipj j Projects. .. |
tO I'etI'leVe the Guick Launch iMates
ae
mOdel‘ @I ’7 * | ’7 @ | -0 Find ... Options. .. | Open I Cancel |
A4

3. Place a copy of the Bushing
half toward the left side of
the graphics window, as
shown in the figure.

4. Inside the graphics window,
right-click once to bring up
the option menu and select
Done to end the placement
of the part.

5. Inthe Assembly panel, select the Constrain
command by left-clicking once on the icon. Joint Cﬂnstgn

& Hide Al ‘

Relaticnships =
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6. On your own, apply two Mate constraints to fully assemble the part as shown.
Note the part still has one degree of freedom available; it can still rotate about the

center axis.

7. In the Assembly panel, select the Place Component
command by left-clicking the icon.

Assemble EEETGTA0

] '*'g Free Moy
E, . %5 FreeRotd 8. On your own, place copies of the Bushing.ipt and the
Plagas Hreazta Axle-8.ipt parts toward the right side of the assembly as
Place Component (F) shown

Com| Specifies one or maore fild
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Assembling Bushing and Axle

Design 30 Model Inspect T

s I:IZI oy Show 1. Inthe Assembly panel, select the Constrain

command by left-clicking once on the icon.
Joint [Constrain

F Hide All |

‘ Relatl Constrain (C)

2. On your own, apply a Mate
constraint to align the center axes
of the two parts as shown.

3. Also apply a mate constraint to (eTNS
align two of the flat surfaces on
the two parts.
Place Constraint

Assembly |Moticn I Transitional I Constraint Set|

4. Inthe Place Constraint dialog box,
set the constraint Type to the

Type
E@@ 1 & Flush constraint.

Offeat: Solution

0.000 in 3 Py
e e
|

v &' [CE

o | Coma )

Selections

5. On your own, select the two end
surfaces to align the Ax/e to the
Bushing as shown.
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Place Constraint @

Assembly | Mation | Transitional | Constraint Set |

EaaEa

Selections

oy
Offset: Solution
0.000 mm 3
| R &

| ok

|| cancel

|

J [ apply

7. Select the flat face of the Bushing
half part as shown.

6. Inthe Place Constraint dialog box, set
the constraint Type to the Mate
constraint.

8. Select the corresponding flat surface
of the Axle-8 part as shown.

9. Click on the Apply button to accept

the selections and apply the Mate
constraint.

o
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10. On your own, repeat the above steps and constrain the vertical face of the
Bushing to the left side of the Motor-Drive part as shown.

F l Tl |
« ikl - 11. In the Assembly panel, select the Place Component
o .. .
Assemble LIS command by left-clicking the icon.
o Ci} "I"lj Free Moy
@‘ G5 Free Rotd 12. Select the Peg 1-Module design in the list window.
Plagas—Craata Click on the Open button to retrieve the model.
Place Component (P)
Com Specifies one or more fil{ | MESESSSAILE I 2
Look in: IE‘ Basic Car j Q N R
MAT Sound Sensor.iam %NXT Ultrasonic Sensor.iam @Tire
M=T bouch sensor - Base.ipt Tire
M=T bouch sensor - Nose. ipt Peg 2-molsgle Double.ipt %Wh
=T kouch sensor -Top.ipt @Peg 3-module with bushing.ipt %Wh
1 3 Place four copies MXT Touch Sensor.iam Peq 3-module.ipt
: MET ultrasonic sensor - Base.ipt @Peg half-axle.ipt
Of the pal't around MXT ultrasonic sensor - Eye.ipt Peq.ipt
the Current =T ultrasonic sensor - Top.ipt %swivel-Rear.iam
4 | »
assembly model. A
File name: IPeg 1-module.ipt j
Files of type: IEomponent Files [*.ipt; .iam) j
Project File: IParametric-ModeIing-Exercises.ipj j Projects... |
Cuick Launch iMates
| ae
@I ’7 . ’7 ® | =0 Find ... Options. .. | Open | Cancel |

14. Inside the graphics window, right-click once to bring up the
option menu and select OK to end the placement of the part.
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15. On your own, apply the Mate constraints to assemble the four copies of the Peg
1-Module part as shown.

Completing the Motor-Right Subassembly

EH = =2 e~
g 1. In the Assembly panel, select the Place Component
Assemble RSl command by left-clicking the icon.

i Ci} '*'g Free Moy
% & Free Rots 2. On your own, place one copy of the Peg 2-module
Plagas—Crazta Double part, Cross Block 2x1 module part and Peg

”| Place Component (P) half-axle part into the assembly.
Com| Specifies one or maore fild
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Design 30 Model Inspect T

(2 I:F oy Show 3. In the Position panel, select the Constrain
command by left-clicking the icon. On your own,

Joint |Constrain assemble the three parts as shown in the figure.

& Hide Al

Relall Constrain (C)

= [R] e ~
Assemble hf;.ir'nplif'_-,-'

% Ci? '*'G Free Move | (]

':"D Free Rotate

Dlare Create | |

4. On your own, Save the completed model as a
subassembly, using the name: Motor-Right.iam.

21X
Save in: IE‘ Basic Car j Q [,’ 2 -
Marne =~ | Size | Tvpe =
[ 0ldversions File Folder
Eh.ﬂ.rm.iam TAKE  Adtodesk Inventor ...
E!’]Base Frame.iam 120KE  Adtodesk Inventar ...
EhFrame—Center.iam 76KE  Autodesk Inventor ...
E!’iFrame—Front.iam 92 KB Autodesk Inventor ... __|
E Frame-Rear.iam S3KE  Autodesk Inventar ...
EhFuIIl Jdam 115KE  Adtodesk Inventor ...
EbHead.iam 87 KB  Autodesk Inventor ...
EhMotor-LeFt.iam 91 KE  Audtodesk Inventor ...
E!’iMotor-Right.iam 92KE Autodesk Inventar ...
«| | »
File: name: IMotor-Hight.iam j
Save az type: I.&utodesk Irventor dzzemblies [.iam) ﬂ
Ell Preyvigw I Cptions. .. | Saye Cancel
4
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Starting the Main Assembly

M= = S . . : :
M — 1. Select the New File icon with a single click of the
New (Ctrl+M) left-mouse-button in the Quick Access Toolbar as
[g‘% Move shown.
; O . Dttt

2. Select the English units set and in the Template list; select Standard(in).iam
(Standard Inventor Assembly Model template file).

4 | Templates .
. - ¥ Part —Create 2D and 3D ohjects
. English

, Metric

; Mold Design @ @
Sheet Standard
Metal  (in).ipt

(in).ipt

¥ Assembly — Assemble 2D and 30 components

Hh & T

Mold |Standard | Weldment
Design (inj.'&m [AMNST).iam

{in).iam

3. Click on the OK button in the New File dialog box to accept the selected settings.

- B Customize @® 4. 1In the Ribbon toolbar, select the Tools tab.

—

(—
Inspect Tools  Manage View  Env

application | Docurpent & 5. Select the Document Settings command as
Options | Settlags | 2b Add-Ins shown.

Document Settings

Assembly2 Document Settings

6. In the Assembly2 Document Settings dialog Standard Units |5kf,t.;|-. | Modelin
box, click on the Units tab as shown. Uit
— Lnies
7. Set the Length Units to centimeter as shown. Length
8. Click on the OK button to accept the selected . g
settings. :
|degree 1|r|

o The Standard Inventor Assembly Model template file contains predefined settings
including default 3D view orientation and default 2D drawing views setup. With
Autodesk Inventor, we are allowed to mix different units within the same file.
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[

Aszzemble

9. Inthe Assembly panel, select the Place Component
command by left-clicking once on the icon.

Simplify

- '*'g Free Moy
i ‘Ef P ':’Q Free Rotg
% Place Component (P) 10. Select the Beam 13-module part in the list window.
Click on the Open button to retrieve the model.

Com| Specifies one or mare fild

Place Component

2
Laak ir: I I Basic Car o m

[ {)beam 11-module.ipt @Bushing half ipk %Fra
'_‘E:E-am 13-odule.ipk @Bushing.ipt %Fra
l'l Beam 15- dule.ipt @Bushing-N.\pt %FU"
.'i Bieam Angular-2x4.ipt @Cross Elock 2-module.ipt He:
[ JEeam Angular-3x5.ipt @Cross Elock 2:¢1 module.ipt @Hut
[Eieam angular-4x6 ipt @Crnss Elock 3-module. ipt @Hut
([J5eam double bent-7x1:2.ipk @DC Gearhead Motor,ipt @Hut
{{JBushing Axle Extendsr.ipt %Frame-Center.\am %MUI

1 [l
File: name: IBeam 13-module.ipt j
Files of type: IComponent File= [*.ipt; “.iam) j

Project File: IParametric-ModeIing-Exercwses.ipi j Projects... |

uick Launch Mates
3 [ﬁ {@ E

11. In the graphics area, place two copies of the part, with the first copy to the left
side, as shown in the figure.

Find ... | Options... | Cpen | Cancel |

#

12. Inside the graphics window, right-click once to bring up the option menu and
select Done to end the placement of the Beam 13-module parts.
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-

Simplify

Cil' '*'G Free Moy

':"Q Free Rotd

13. In the Assembly panel, select the Place Component
command by left-clicking once on the icon.

Azzemble

Croate

14. Select the Frame-Front assembly in the list window.
Click on the Open button to retrieve the model.

Place Component (P)

Com Specifies one or more fild

Place Component

Laok in: I@ Basic Car j Q T M-
@Bushing half.ipt

Bushing.ipt gdear,
{)Bushing-i.ipt B Fullt iam [
@Cross Block 2-module.ipt Eb Head.iam @Nm
(1) cross Black 2x1 madule.ipt ) Hub S 26.ipt fme
@Cross Block 3-module.ipt @Hub - cenker,ipk @NX'I
@DC Gearhead Mator.ipt @Hub - small.ipk @Nm
%Frame{enter.iam %Motor-Left.iam @Nm
Kl 1 Fl
File: name: IFrame-Front.iam j
Files of type: IEomponent Filez [*.ipt; *.iam) j
Project File: IParametr\c-ModeIing-Exercwses.ipj j Projects. .. |

GQuick Launch iMates
=) {ﬁ { ®© |82

15. In the graphics area, place a copy of the Frame-Front subassembly to the right
side of the other pieces.

Find ... | Options... | Open | Cancel |
4

16. On your own, repeat the above steps and place a copy of the Frame-Center
subassembly to the left side of the screen.
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Assemble the Frame and Motors

Design 3D Model Inspect T

] .. Show 1. Inthe Assembly panpl, .select the Congtrain
command by left-clicking once on the icon.

loint |Constrain

I:F!l:-l' Hide 4ll | Place Constraint 2
Assembly |Moﬁon | Transitional | Constraint Setl

| Relall Constrain (C)

Selections

Type
(Ela)dm]a) ol
2. Inthe Place Constraint dialog box, | Offset Solution

switch to the Mate constraint. 0000 mm ' @‘

W&o O

3. Select the inside face of the inner
vertical face of the left Beam 13-
module as shown.

4. Select the circular face
of the Peg part of the
Frame-Front
assembly as the 2" item
for the Constrain
command.

5. Click on the Apply
button to accept the
selection and apply the
Mate constraint.

el
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6. Select the first hole feature, on the
inside cylindrical surface, of the left
Beam 13-module as shown.

7. Select the circular face of the
Peg part of the Frame-Front
assembly as the 2™ item for
the Constrain command.

8. Click on the Apply button to
accept the selection and apply
the Mate constraint.

ol

9. On your own, repeat the above steps and assembly the Frame-Center
subassembly and the other Beam 13-module as shown.

e Note the two subassemblies can still
pivot about the center axes connected
to the Beam 13-module parts.
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Assemble the Motor Assemblies

RO Simplify IS

@l C‘i} '*'G Free Moy
E— ©~ Free Rotd
Plagas o

Croats

"| Place Component (P) 2.

Com Specifies one or more fild

In the Assembly panel, select the Place Component
command by left-clicking the icon.

Select the Motor-Left assembly in the list window.
Click on the Open button to retrieve the model.

Place Component

rt Center Files

Quick Laurich iMates
o) {ﬁ {@ | 82

21X
Lk it I | Basic Car j o _? % -
Bushing half ipt %Frame—Front.iam %Mot
Bushing.ipt %Frame-Rear.iam @NX‘I
Bushing-H. ipt BhFullt iam e
Cross Block 2-module.ipt %Head.iam @NX'I
Cross Block 231 madule.ipt E)Hub 56 26.ipt e
Cross Block 3-module.ipt @Hub - cenker.ipk @NX‘I
O Gearhead Motor.ipk @Hub - small ipk @NX‘I
Frame-Center.ian @ k|
d - il
File name: IMotor-LefLiam j
Files of type: IEomponent Files [.ipt; ".iam) j
Project File: IParametric—ModeIing—Exercises.ipj j Projects. .. |
Find ... | Cptions., .. | Qpen | Cancel |
e

3. Place a copy of the Motor-Left assembly to the left side of graphics area.

X

4. Inside the graphics window, right-click once to bring up the option menu and
select Done to end the Place Component command.
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tzemble

4 o 5. Select the Free Rotate command by left-clicking
_j" (3 Free Move ‘7 O once on the icon.
|
reate Joint Cons|
nt = | Positio Free Rotate (G)

6. On your own, use the left-mouse-button and rotate the Motor to the orientation as
shown.

Design 3D Model Inspect T
i P Show 7. In the Assembly panel, select the Constrain
[IZI ! command by left-clicking once on the icon.

loint |Constrain

& Hide All

| Relatl Constrain (C)

8. Select the last hole feature,
on the inside cylindrical
surface, of the left Beam
13-module as shown.
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9. Select the circular face of the back Peg
part of the Motor-Left assembly as the
27 jtem for the Constrain command.

10. Click on the Apply button to accept the

selection and apply the Mate
constraint.

)

11. On your own, repeat the above steps and align the other Peg as shown.

12. Also apply a Mate constraint to align the inside surface of the Motor
subassembly as shown.
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13. Adjust the positions of the Frame-Center and Frame-Front subassemblies by
drag-and-drop with the left-mouse-button.

30 Model  Inspect
@ P Show 14. In the Assembly panel, select the Constrain
[IZI ' command by left-clicking once on the icon.

loint |Constrain

& Hide Al

‘ Relatl Constrain (C)

15. Select the last hole feature, on the
inside cylindrical surface, of the
Motor-Base part as shown.

16. Select the curved surface of the Axle
part of the Frame-Front assembly as
the 2" item for the Constrain
command.

17. Click on the Apply button to accept
the selection and apply the Mate
constraint.
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Azzemble

Simplify

Ci? ‘*’g Free Mo

':’g Free Rotd

Craate

| Place Com ponent (P)

Com Specifies one or more fil

18. In the Assembly panel, select the Place Component

command by left-clicking the icon.

19. Select the Beam Angular-2x4 part in the list window.

Click on the Open button to retrieve the model.

Place Component e |
Look ir: I@ Basic Car j Q 5.0
Center Files ﬂaxle-lﬂ.ipt @Beam 11-module.ipt @Bus
f Base Frame.iam @Beam 13-module.ipt @Bus
=
HBasic-Car.jam @Beam 15-module.ipk @Bus
@Beam J-Center.ipt Beam Angular-2x4.ipt @Cro
@Beam 3-module.ipt il Beam Anguksi-3x5.ipt @Cro
@Beam S-module.ipt @Beam Angular-4:x6 ipk @Cro
@Beam F-module.ipt @Beam double bent-7x1:x2.ipt @DC
@Beam S-module.ipt @Bushing Axle Extender.ipt %Fra
ol I3
File name: IBeam Angular-2x4. ipt j
Files of type: IEomponent Files [*.ipt; ".iam] j
Project File: IParametric-ModeIing-Exercises.ipj j Projects. .. |
Guick Launch iMates
| e
@l ’7 . I T, ’7 ® | L Find ... | Options. .. | Open | Cancel |
Y

20. Place one copy of the part toward the left side of the graphics window.

21. On your own, assemble the Beam Angular part to lock the Frame-Center and
Frame-Front in place as shown.
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Adding the Motor-Right Subassembly to the Main Assembly

Assemnble EESTHTNN

Cf‘ '*'g Free Moy

':b Free Rotd

Craate

F s =" ar=

command by left-clicking the icon.

In the Assembly panel, select the Place Component

Select the Motor-Right assembly in the list window.

Click on the Open button to retrieve the model.

7| Place Com ponent (P)

Com Specifies one or more fild

Place Component 2=l
Laak in: I 125 Basic Car j Q2o
;__.I"-'1|:|t|:|r-F!.i|;|"|t.iarn EIMAT brick - Jackz.ipt By
[N brick L Basel Jipt T brick - screent ipt e
[ ()M brick - Base.ipt M brick - Screenz.ipt e
[{NKT brick - Baseo.ipt BT Brick.iam D
[MAT brick - Buttonl.ipt EMT light sensar - Base.ipt me
[ {JMT brick - Buttonz.ipt ET light sensor - Light Red.ipt (M1
[ {JMT brick - Button3.ipt 0T light sensor - Light White.ipt Fgne
(JMAT brick - Jack1.ipt IR light sensar - Tap.ipt fmx
1 o
File name: IMotorrFlight.iam j
Files of type: IEomponent Files [*ipt; “.iam) j
Project File: IParametric-ModeIing-Exercises.ipj j Projects. .. |
Quick Launch iMates
| a|
@l ’7 . I ) ’7 ® | L = Find ... | Options. .. | COpen | Cancel |

4

3. Place one copy of the assembly toward the right side of the graphics window.

4. On your own, repeat the same procedure to assemble the Motor-Right assembly
and a copy of the Beam Angular-2x4 part as shown.
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Assemble the Rear Swivel Assembly and Wheels

T WG

LI Simplify

1. Inthe Assembly panel, select the Place Component
command by left-clicking the icon.

&l Ci" '*'G Free Moy
[ﬁ: €5 Free Rots 2. Select the Beam 11-module part in the list window.
ac

Feazta Click on the Open button to retrieve the model.
i F'IEIEE 'CGI'I'I Pﬂ‘nent {FI:I Place Component |
Corm Specifies one or more filg Lookis [ B o2 m-
ﬂaxle-lﬂ.ipt Beam 11-module.ipt
%Basa Frame.iam (TBeam 1 k odule.ipt @Bus
%Baswc-car.lam @Beam 15-rnodule.ipt @Bus
3. Place one copy of the oo el
1 @Baam S-module.ipt @Beam Angular-4:x6 ipt @Cro
part toward the rlght @Baam T-mndule.igt @Beam dDLgIh|E hant-?:lxz.ipt @DC
Slde Of the graphlcs @Baam g-module.ipt @Bush\ng Azxle Extender.ipt %Fra
window. ol — i
File name: IBEam 11-module.ipt d
Files af tppe: IEomponenl Files [.ipt; ".iam] j
Project Fils:  [Parametric-Madeling-Exercises.ip | Projects...
Quick Launch iMakes
’7 . | | ’7 ® | 3% Find ... Options. .. | Open | Cancel |
A

4. On your own, assemble the part as shown.
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T . WCesaHGE

Assermnble TG0

[ji_‘ +@ Free Mo
Pladss | rraate CJC' Free Rota

”| Place Component (F)

command by left-clicking the icon.

6. Seclect the Frame-Rear assembly in the list window.

Click on the Open button to retrieve the model.

In the Assembly panel, select the Place Component

Com| Specifies one or more fild

Place Component 2=l
Lok in: I |5 Basic Car j Q ¥ % G-
@Bushing half ipt % Frame-Front.iam %Mot
{{)Bushing.ipt n
{{)Bushing-h.ipt B Ful n
@Cross Block 2-module.ipt % Head.iam @Nkﬂ
(1) Crass Black 2x1 module.ipt () Hub St 26.ipt n
@Cross Block 3-module.ipt @Hub - center.ipt @NX'I
@DC Gearhead Matoript @Hub - small.ipt @Nm
%Frame{enter.iam % Motor-Left.iam @NX'I
Kl _ |
File name: IFrame-Hear.iam j
Files of type: IComponent Files [*.ipt; “.iam) j
Project File: IParametric-ModeIing-Exercises.ipj j Projects... |

Quick Launch iMates
2 {ﬁ [@ | &2

Find ... | Options. .. | Open |

7. Place one copy of the Frame-Rear assembly next to the assembly.

8. Inside the graphics window, right-click once to bring up the option menu and
select Done to end the Place Component command.
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9. Select the Rotate Component command by left-

) Free M ki i
j" (7 FreeMove (] clicking once on the icon.

L
-
reate oint =ons 10. On your own, use the left-mouse-button and rotate the

subassembly to the orientation as shown.

it ‘ Positio Free Rotate (G)

11. On your own, apply the necessary constraints to align the subassembly to the two
Peg 2-module Double parts as shown.
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=l |

Azzemble

Ci}*}*

(]
Craata

Simplify

Free Moy

c’g Free Rot3

[Dﬂ
Pladas

7| Place Com ponent (P)

Com Specifies one or more filg

12. In the Assembly panel, select the Place Component

command by left-clicking the icon.

13. Select the Swivel-Rear assembly in the list window.
Click on the Open button to retrieve the model.

Place Component

File name:

IswiveI-H ear.iam

Files of type: IEomponent Files [*.ipt: *.iam]

[
|

Project File: IParametric-ModeIing-Exercises.ipj

j Projects... |

2lx|

Laok in: I = Basic Car j (e 5 il
i.'- MXT Ultrasanic Sensar .iam @Tire SEx 26 YR.ipk
(Feq 1-module.ipt @Tire small.ipk
({)Peg 2-module Double.ipt %Wheel 56 % 26 YR.iam
({)Peq 3-madule with bushing.ipt %Wheel-small.iam
il Peg 3-module.ipt
il Peq half-axle.ipt
-

R

Find ... | Options. .. |

Quick Launch iMates
o) {ﬁ [@ | &2

Open | Cancel |

Y

14. Place one copy of the Swivel-Rear assembly next to the assembly.

15. On your own, rotate the assembly to the orientation shown.
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G |:|:| EEI;- Show
"
loint [Constrain| =
| ‘:E.;' Hide All |
Relal] Constrain (C)

17. Select the center hole feature, on
the inside cylindrical surface, of
the Peg 5-Module part as shown.

20. Select the bottom surface of the
Beam 3-Center part as shown.

16. In the Assembly panel, select the Constrain
command by left-clicking once on the icon.

18. Select the curved surface of the Axle part
of the Rear-Swivel assembly as the 2™
item for the Constrain command.

19. Click on the Apply button to accept the
selection and apply the Mate constraint.

21. Select the top surface of the Bushing
part of the Rear-Swivel assembly as
the 2" item for the Constrain
command.

22. Click on the Apply button to accept the
selection and apply the Mate
constraint.
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23. On your own, assemble a copy of the Bushing to the Axle of the Rear-Swivel
assembly as shown.

24. On your own, assemble a Wheel-Small assembly and two copies of the Wheel
56x26 VR assembly as shown.
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Assemble the NXT Micro-controller

L

1. Inthe Assembly panel, select the Place Component
command by left-clicking the icon.

Qi Cj" + Free Moy
[G?: 2. Select the NXT-Brick assembly in the list window.
Pladas

Assemnble EESTHTNN

':b Free Rots . .
Frazta Click on the Open button to retrieve the model.
7| Place Component (P)

o = Pl C t 7| x
Com Specifies one or more fild 2oo omponet L
Loak in: I I Basic Car j e 1‘ ® [E-
Matar-Right iam [T brick - Jackz.ipt Brea
KT brick - Base1.ipt [{IMAT brick. - screent.ipt nx
3 . Place one Copy Of T brick - Base.ipt [T brick - Screenz.ipt [l
MT brick - Basen.ipt D
the assembly towar d 1T brick - Buttand.ipt MT it sensor - Base.ipt mex
. . [T brick - Buktonz.ipt @NXT light sensar - Light Red.ipt @NM
the I'lght side of the KT brick - Butkonid,int [EDIMAT licht sensor - Light White ipt Bgre
gl’aphlcs Wll’ldOW. AT brick - Jackl.ipk @NXT light sensar - Top.ipt @NX'I
‘ [— ]
File name: [T Brick.iam |
Files of type: IEomponent Files [".ipt; ".iam] j
Project File: IParametric-Modeling-Exercises.ipj j Projects. .. |
Guick Launch iMates
(0]o]
@I ’7 . ’7 @ L =] Find ... | Options. . | Open | Cancel |
Vi

4. On your own, also place two copies of Peg 1-Module and Beam 5-Module
into the assembly as shown.
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s I:IZI ey Show 5. Inthe Assembly panel, select the Constrain
" command by left-clicking once on the icon.
loint |Constrain| =
& Hide Al |
| Relatl Constrain (C)
6. We will first align the
bottom of the NXT-Brick

to the Frame-Front
assembly. Select the
outside cylindrical surface
of the right Peg 1-Module
part of the Frame-Front
assembly as shown.

7. Select the center axis of the first hole
feature on the bottom right of the NXT-
Brick assembly as shown.

8. Click on the Apply button to accept the
selection and apply the Mate
constraint.
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9. Select the outside cylindrical surface of
the left Peg 7-Module part of the
Frame-Front assembly as shown.

10. Select the center axis of the first hole
feature on the bottom left of the
NXT-Brick assembly as shown.

11. Click on the Apply button to accept
the selection and apply the Mate
constraint.

12. On your own, assemble the two sets of Peg 1-Module and Beam 5-Module
parts as shown.
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Assemble the Sensors

-

Simplify

1. Inthe Assembly panel, select the Place Component
command by left-clicking the icon.

Azzemble

le' '*'@ Free Moy

(] J
.| T Free Rotd

2. Select the Arm assembly in the list window. Click on
the Open button to retrieve the model.

7| Place Com ponent (P)

Com Specifies one or more fil{ | HESEIIEAIN 2x
Loak in: I = Basic Car j e ?‘ % [
Oldversions @axle-lﬂ.ipt @Bee
Base Frame.iam @Bee
3 N Place one Copy Of axlebfnotched.ipt %Basic{ar.iam @Bee
axle-3.ipt Beam 3-Center.ipk Bez
the assembly axle-4.ipk @Beam 3-module.ipk @Bea
toward the rlght axle-5.ipt {)Beam S-module.ipt {Bee
. . axle-6.ipk @Beam F-module.ipt @Bee
Slde Of the graphlcs axle-5.ipt @Beam 3-module.ipt @Bus
window. ]
File name: IArm.iam j
Filez of type: I Component Files [.ipt; *.iam) j

Project File: IParametric-Modeling-Exercises.ip] j Projects. ..
GQuick Launch iMates

(2] 2]

el [h L [@I»q

4. On your own, also place a copy of the Head assembly into the current assembly
as shown.

Find ... | Options... | Open | Cancel |

I3
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s I:IZI &% Show 5. Inthe Assembly panel, select the Constrain
command by left-clicking once on the icon.
loint |Constrain

& Hide Al |

| Relatl Constrain (C)

6. Align the center axes of the upper
Peg on the Arm assembly to the
corresponding hole feature on the
NXT-Brick assembly as shown in
the two figures.

7. On your own, align the center axes of
the lower Peg on the Arm assembly to
the corresponding hole feature on the
NXT-Brick assembly. (The top of the
Beam 9-module part on the Arm
assembly is parallel to the top of the
NXT-Brick.)

8. Apply another Mate constraint to
complete assembling the Arm as
shown.
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9. Align the two Pegs on the Head assembly to the bottom of the NXT-Brick
assembly as shown.

10. Complete the assembly by adding another Mate constraint to align the Head
assembly as shown.
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